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Notices

This information was developed for products and services offered in the U.S.A.
Note to U.S. Government Users Restricted Rights -- Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in
new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The
materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of
individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to
the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in
any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM's application programming interfaces.
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Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

Eserver® 0S/400®
iSeries™ WebSphere®
i5/08™

DB2 Universal Database™

DB2®

IBM®

The following terms are trademarks of other companies:
Intel, Intel Inside (logos), MMX, and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or
both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.
SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.

3 IBM Express Runtime 'HN DEMAND BUS'NESS



IBM Software Group

Objectives

= The objectives of this module are to:
— Demonstrate how to deploy a solution

— Highlight some key points during the deployment
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Agenda

Overview of deployment

Configuration parameters

Two ways to deploy: Solution launcher from media (CD/DVD)
and staging server

Deploying to the different platforms

Deploying to multiple physical systems

What to do if you have one of the components installed
Deploying on IBM i5/0S
Validating the deployment (log files, running the application)
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Overview of deployment
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Overview of deployment

The Deployment Wizard installs and
configures the IBM middleware and
applications in a single process.

There are two distinct ways to deploy Package solution , Single deploy
[l . t CDIDVD lllllll
the solution with the Deployment staging server procedure

Wizard: solution
— CD/DVD deployment using _

Solution Launcher

CD/DVD
— Staging Server using a locally .
installed deployment wizard
- Deployment options supported el

ploy P ' PP -

by both methods: D

— Local deployment using - —

deployment wizard Z End

— Remote deployment using Staging customer
deployment wizard and Server system(s)

(or laptop)

installation agent
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Deployment Wizard

= Provides a simple graphical user interface (GUI) to deploy a
solution and minimize the amount of setup required

= Presents a solution as a list of tasks and accomplishes them
sequentially

I e S

= End Users must provide a
minimal set of required
parameters and can
optionally change many
additional parameters

Deployment wizﬂkgl: Wel to the deploy 1t wizard

The deployment wizard helps you provide information that is required to deploy a
solution.
The deployment wizard helps you do the following tasks:

» Select tasks to deploy

# Specify target computers

» Configure deployment parameters for tasks [%
» Review summary infarmation for tasks

To continue with the deployment wizard, click File » Open, and select a solution to
deploy. When vou have selected a solution, click Next

&
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Configuration parameters
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Provide configuration parameters

= Why do we need the configuration parameters?

— To meet different deployment requirements by using different
parameters for middleware components and applications

— To ensure there are no conflicts between components
= What parameters do | provide?

— There are a few required parameters for each component, such as
user ID, password, and port number.

— There are some optional parameters that an end user can modify.

— For most parameters, a default value is provided by the solution.

IBM Express Runtime
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Configurable parameters for DB2 Universal Database
(UDB) Express v8.2*

= Required parameters
— Target directory
— DB2 administrator user ID

— DB2 administrator password

= Optional parameters
— Create Start menu shortcuts
— Languages support
— Add features to installed version

*IBM i5/0S is different. Refer to the i5/0S section.
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Configurable parameters for WebSphere Application
Server - Express v6.0*

= Required parameters (default values provided)

— Modify or check the following parameters

 Installation directory

« HTTP Transport port

« Administrative console port

« HTTPS Transport port

« Secure administrative console port

*i5/0S is different. Refer to the i5/0S section.

IBM Express Runtime 'EN DEMAND BUS'NESS




IBM Software Group

Configurable parameters for WebSphere Application

Server - Express v6.0 (cont.)*

= Required parameters (default values provided)

— Make sure there is no port conflict for the following parameters:

Bootstrap port

SOAP Connector port

SAS SSL ServerAuth port
CSIV2 ServerAuth Listener port
CSIV2 MultiAuth Listener port
ORB Listener port

High Availability manager communication
port

Service Integration port
Service Integration port (Secure)
Service Integration MQ Interoperability port

Service Integration MQ Interoperability port
(Secure)

Startup type of the service

= QOptional parameters (default values provided)

— Abort install if required ports are busy

— Run the WebSphere Application Server - Express as a service

*i5/0S is different. Refer to the i5/0S section.

IBM Express Runtime
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Configurable parameters for IBM HTTP Server v6.0*

= Required parameters (default values provided)
— IBM HTTP Destination Directory
— HTTP port
— Admin Server port
— Windows Service UserlD (only for Windows platform)
— IBM HTTP Server port number
— IBM HTTP Server installation directory
— WebSphere Express Application Server - Express installation directory

= QOptional parameters
— Windows Service User Password (only for Windows platform)
— Admin UserlID
— Admin User Password
— WebSphere Express Application Server - Express hostname

*i5/0S is different. Refer to the i5/0S section.
IBM Express Runtime \vO'N DEMAND BUS'NESS
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Two ways to deploy a solution
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Deployment method 1: From media (CD/DVD)

= Deployment from CDs or DVDs means installing the solution

using the CDs or DVDs that contain the setup programs and all
files needed.

= You receive the installation CDs or DVDs from the solution
developer prior to deployment.

— Run the setup programs (Solution Launcher) from CD/DVD

« For example, use |IRU WindowsSetup.exe for the Windows platform.

Note: Deployment on Linux is similar to Windows, except for some minor display differences.
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Start the Solution Launcher.

Choose the language of
preference.

The wizard starts.

Click Next, and the wizard
extracts all components
(JAR files).

IBM Express Runtime

E_\'?: Installer =

e e

_’_f Welcome to the InstallShield Wizard for My
% | Solution

The InstallShield Wizard will install My Solution on your computer.
o conti se Mext.

" v -2
'y ¥ s .
Fiiet - £ ‘-
.. o L
— = Back etz | Cancel
. -.""\\" .
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Install Deployment Wizard and begin deployment

= The wizard installs the
Deployment Wizard.

4%
|

After the installation completes, the
Deployment Wizard runs.

IBM Express Runtime
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Deployment method 2: Staging Server

= The Deployment Wizard can be installed directly on a
machine instead of using the Solution Launcher
method which temporarily installs the deployment
wizard.

= When this method is chosen the deployment wizard is
started from the menu options
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Local Deployment

= Local deployment means installing the solution on the same
machine where you are running the Deployment Wizard.

= The Deployment Wizard can help you to perform the following
steps for a local deployment:
— Select tasks to deploy
— Specify the local system
— Configure deployment parameters for tasks

— Review summary information for all tasks

Note: Deployment on Linux is similar to Windows, except for some minor display differences and
configuration parameters for the underlying products
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Remote Deployment Option

= Remote deployment means Deployment wizard

installing the solution on a
remote system, which we call
a target machine.

= IBM Installation Agent (lIA) Deploy solutions to the
must be installed on the target : target machine
machines prior to deployment.

with a solution package

Target machine with Installation Agent

Note: Installing and configuring IIA on Linux is similar to Windows, except for some minor
display differences.
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Secure your remote installation

= To secure the remote installation, you
must provide a security string on both
systems

— Specify a security string during the I1A
installation.

. You can still modify the string using the
Key Manager.

— Specify a security string in the
Deployment Wizard on the staging
server. You will be prompted to enter a
security string if required. You can
manually set the string by:

. In the Deployment Wizard, select Edit ->
Key Manager.

. Type the security string that you
specified during the IlA installation.

22 IBM Express Runtime

Key Manager on target machine (Linux)

EaKey Management.

Key management securas, controls and authenticates all
daployment requeasts,
Provide a phrase to genarate a pair of security keys to astablish
commmmunication between the staging server and the target
COMmputer,
*Entar | |
phrase:
earify | |
phrase:

Key Manager in deployment wizard (Windows)

requests.

Key management secures, controls and authenticates all deployment

Provide a phrase to generate a pair of security keys to establish
communication between the staging server and the target computer.

*Enter phrase:
=/arify phrase:

Cancel |
'ON DEMAND BUSINESS
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Remote deployment: Target machine

= Remote deployment with the Deployment Wizard is similar to a local
deployment with one difference:
— Provide Host name or IP address of remote machine at the Specify Target

step
— Test the remote connection by clicking the Test connections butto

File Edit %iew Help

3 z &0 %" = IBM Integrated Runtime 2.1 Middleware

Specify Target Computers - \'fehSphere Application Server Express 6.0 and Console manageme_ |

= The rest of the deployment
. + Vielcome extensions forlWindows ||
proceSS IS the Same aS + Select Tasks Provide the hostname Dr_IF'_address for each target computer where you want ta =

P Specify Targets Target computar:

I O Ca I d e p I Oy m e n t . WWehSphere Application 5. =
- Mo previous targets - < Remove |

Selected target computers:

All selected target computers must be running the Windows operating systerm.

The IEM Installation Agent must be running on all selected target computers, except localhost, before
deploying.

'ON DEMAND BUSINESS
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Demo 3 - Installing and configuring IIA on Windows
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Deploying to different platforms
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Deploying to the different platforms

= Currently, the Deployment Wizard supports the following platforms:

—~ Windows
« 2003 Server with SP1, 2000 Advanced Server with SP4, XP Professional with SP 2
— Linux (Intel-based platform)

Red Hat Enterprise Linux 3.0 (AS/ES/WS), SUSE LINUX Enterprise Server (SLES) 8.0/9.0, Red
Flag Advanced Server 4.1

— Power Linux
« SLES 9.0, Red Hat Enterprise Linux AS 3.0
— i5/0S
+ 0S/400 is known as the i5/0S operating system beginning with V5R3.

= Deployment to Windows and Linux (Intel and Power)
— Support local, remote (and CD/DVD delete) deployment
— Can run both deployment wizard and installation agent

= Deployment to i5/0S
— The IBM iSeries can only be the target machine in remote deployment.
— The iSeries can only run the installation agent.
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Deploying to multiple physical systems
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Deploying to multiple physical systems

= The Deployment Wizard supports deploying a solution to multiple
physical systems.

= Refer to the demo for an example of deploying IBM middleware to

the Windows and Linux system. :
Deployment wizard

— Step 1: Open the middleware W age "
solution file using the
Deployment Wizard on the

staging server.

— Step 2: Deploy DB2 UDB
Express, WebSphere
Application Server - Express,
and IBM HTTP Server to both
target machines (Windows
and Linux) at the same time. Target machine

Target machine

. . Linux with
Windows with -
. Installation Agent
Installation Agent installed

installed

28 IBM Express Runtime WN DEMAND BUS'NESS
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A more complex scenario can be supported
= |n this scenario, the solution is
installed on three machines.

— The first one is running Windows to
be a database server.

— The second is running Linux to be an er'ﬁymfﬁt
icati wizard with a
application server. card wit
— The third is running Linux to be an package

HTTP server.

= In a single deployment, the following
installations occur:

— DB2 UDB Express is installed in No.1.

— WebSphere Application Server - E
Express is installed in No.2. :

— IBM HTTP Server is installed in No.3. %

Target machine

1 runs Windows

with Installation
Agent

WAS

Target machines 2
and 3 run Linux
with Installation

Agent

'ON DEMAND BUSINESS’
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Demo 4 - Deploying IBM middleware
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What to do if you have one of the
components installed?*

* This section assumes that you are using a Windows or Linux platform. For i5/0S, refer to the i5/0S section.

31 IBM Express Runtime 'ON DEMAND BUSINESS"
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What to do if you have DB2 installed?

= You can run only one DB2 on the same system.

= You need to consider four scenarios:

* An earlier version is already installed.
« The same version is already installed.
* A later version is already installed.

* An unknown version is installed.

32 IBM Express Runtime WN DEMAND BUS'NESS
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Scenario 1: An earlier version is already installed*

= Upgrade is performed automatically by the DB2
Install package.

= Notice the different actions for Windows and Linux.

— For Windows, it is important to perform the DB2 migration
steps on any data that you have prior to installing the
solution.

— For Linux, this is not so important, since the data can be
migrated after the installation completes.

* Must be careful with these actions. Analyze the impact for other applications on the system.
33 IBM Express Runtime m DEMAND BUSINESS™
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Scenario 2: The same version is already installed

= The Deployment wizard displays the “already
exist” message and skips the installation.

IBM Express Runtime 'EN DEMAND BUS'NESS
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Scenario 3: A later version is already installed

= The Deployment wizard displays a failure message
and terminates the installation.

= Analyze other applications on the system that use
DB2* and decide the actions to take.

* Be careful with these actions. Analyze the impact for other applications on the system.

35 IBM Express Runtime WN DEMAND BUS'NESS
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Scenario 4: An unknown version is installed

= The Deployment wizard displays a failure message
and terminates the installation.

= You should:
— Uninstall DB2 manually.”

— Run the deployment wizard again to install a solution that
includes DB2.

* Be careful with these actions. Analyze the impact for other applications on the system.

36 IBM Express Runtime WN DEMAND BUS'NESS
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What to do if WebSphere Application Server -
Express is installed?

= You can run multiple occurrences of WebSphere Application
Server - Express on the same system.

= You still need to consider the four scenarios:

— Scenario 1: An earlier version is already installed.
+ Create a new installation.
— Scenario 2: The same version is already installed.

+ Keep the existing one.
» Create a new one for your specific reasons.

— Scenario 3: A later version is already installed.
« Create a new installation.

— Scenario 4: An unknown version is installed.
* Create a new installation.

37 IBM Express Runtime (EN DEMAND BUS'NESS
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Choosing the WebSphere Application Server -
Express installation

= To create a new installation

— Choose a different <WAS INSTALL> directory to create a
new WebSphere Application Server - Express installation.

— Modify the port parameters to make sure there are no
port conflicts.

= To keep existing installation
— Choose the existing <WAS INSTALL> directory.

— The Deployment Wizard terminates current installation
and uses the existing version.

38 IBM Express Runtime (EN DEMAND BUS'NESS
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What to do if IBM HTTP Server is installed?

= You can run multiple occurrences of IBM HTTP Server on the
same system.

= You still need to consider the four scenarios:

— Scenario 1: An earlier version is already installed
+ Create a new installation.

+ Keep the existing one if the version is 2.0 or later.

— Scenario 2 : The same version is already installed.
* Keep the existing one.

+ Create a new one for your specific reasons.

— Scenario 3 : A later version is already installed.
* Create a new installation.

— Scenario 4 : An unknown version is installed.
» Create a new installation.

IBM Express Runtime
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Choosing the IBM HTTP Server installation

= To create a new installation

— Choose a different <IHS INSTALL> directory to continue
with a new IBM HTTP Server installation.

— Modify the port parameters to make sure there is no port
conflict.

= To keep existing installation
— Choose the existing <IHS INSTALL> directory.

— When an earlier version (2.0 or later) of IBM HTTP
Server is installed in the target directory, the Deployment
Wizard upgrades it.

40 IBM Express Runtime m DEMAND BUS'NESS
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Tip to use existing components

= If applications are meant to use shared, already
installed, components (WebSphere Application
Server - Express, IBM HTTP Server, or DB2 UDB

Express)

— Use care to minimize the possibility of contention with
another application that is sharing the same components.

— We recommend that you add a prefix for the names to
minimize chance of naming conflicts.

— Ask the administrator of the existing components for help.
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Deployment on i5/0S

42 IBM Express Runtime 'ON DEMAND BUSINESS"
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Deploying to i5/0S

= i5/0S is an integrated platform with DB2 UDB Express and
IBM HTTP Server integrated into the operating system.

— WebSphere Application Server - Express is an optional
component to be installed.

= During deployment from IBM Express Runtime to i5/0S
— DB2 Express does not pertain so it is not included for i5/0S

— IBM HTTP Server installation

* Deployment wizard applies the latest PTFs to IBM HTTP Server on
iSeries
— WebSphere Application Server - Express installation

- If no WebSphere Application Server - Express is installed, the
Deployment Wizard installs it without creating server instances.”

* The WAS Configuration application completes the creation of server instances.
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Validating the deployment

44 IBM Express Runtime 'ON DEMAND BUSINESS"
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Validating the deployment

= Deployment Wizard Status panel
— Lists the deployment result of each task

— The Master log can be viewed using the Master log button

= Detailed Messages panel

— Accessed using the Detailed Messages button on the Deployment Wizard
Status panel

— The log file for each message can be viewed using the View Details button
= Log files

— View Master log — In the Deployment Wizard, select View->Master log

— <lInstallation_Directory>/SolutionEnabler/logs/

— <lInstallation_Directory>/SolutionEnabler/deployment/logs

— <Installation_Directory>/lIA/logs/ (on a target machine only for remote
deployment)

IBM Express Runtime WN DEMAND BUS'NESS
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Use diagnostic logging
Use diagnostic logging only for debugging:

Browse..

Deployment Package Path 221 \SahaionEnsblericomibrijsetwebservertres

1. In the Deployment Wizard, select Edit ->
Preference. I

either the communication port or the data port, an open portwill autornatically be selected foryou,

Data Port Number UE:
Maximurm Data Connec tions 53‘
Communication Port Rurmber 03.

2. Click the Diagnostic Trace button. _ -
3. Select the checkbox for the option tml\ I,

to enable.

Help oK || ancal

4. Specify the file name and size of the logs.

5. Click OK.

Enabling a diagnostic trace might slow system performance
significantly. Request a trace only if necessary for troubleshooting.

MNote: Atrace is enahled only for this Solution Deployer session.

[ Enahle the suppodframework frace

Log File Mame: |IRU_Supp0r1Trace.I0g

Maximurm Flle Size | 20 MB

6&@9 the Solution Deployer trace:

Log File Mame: IIE'U_De_bugTrace.Iq_g

Maximum File Slze | 20|ME
Help | oK | Cancel |
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Preview of Autonomic Log and Trace Analyze
= Express Runtime Console v2.1 provides the Log and Trace
Analyzer (LTA) tool

— Process, combine, and correlate log data from any Express
Runtime component or middleware

— Simplify the process of tracing and debugging a problem

Logs of WebSphere Application
Server - Express, DB2 UDB Express,

IBM HTTP Server ) Log and Trace Analyzer

Unified, Simplified,

Effective

o [T
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End of the module
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